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Abstract— These instructions give you guidelines for preparing papers for DBIT Tech Journal. Use this document as a
template if you are using Microsoft Word 6.0 or later. Otherwise, use this document as an instruction set. The electronic
file of your paper will be formatted further at DBIT. Paper titles should be written in uppercase and lowercase letters, not
all uppercase. Avoid writing long formulas with subscripts in the title; short formulas that identify the elements are fine
(e.g., "Nd–Fe–B"). Do not write “(Invited)” in the title. Full names of authors are preferred in the author field, but are not
required. Put a space between authors’ initials. Define all symbols used in the abstract. Do not cite references in the
abstract. Do not delete the blank line immediately above the abstract; it sets the footnote at the bottom of this column.

Index  Terms— Enter key  words  or phrases  in  alphabetical  order,  separated  by  commas.  For  a  list  of  suggested
keywords, send a blank e-mail to keywords@  dbit.in

I . INTRODUCTION

THIS document is a template for Microsoft Word versions 6.0 or later. 
If your paper is intended for a  conference, please contact your conference editor concerning acceptable word

processor formats for your particular conference. 

II . GUIDELINES FOR MANUSCRIPT PREPARATION

When you open DBIT TECH-JOURNAL.DOC, select “Page Layout” from the “View” menu in the menu bar
(View | Page Layout), (these instructions assume MS 6.0. Some versions may have alternate ways to access the same

This paragraph of the first footnote will contain the date on which you submitted your paper for review. It will also contain support information,
including sponsor and financial support acknowledgment. For example, “This work was supported in part by the DBIT. Department of Computer
under Grant BS123456”. 

functionalities  noted here).  Then,  type  over sections of  TECH-JOURNAL.DOC or cut  and  paste  from another
document and use markup styles. The pull-down style menu is at the left of the Formatting Tool bar at the top of
your Word window (for example, the style at this point in the document is “Text”). Highlight a section that you want
to designate with a certain style, and then select the appropriate name on the style menu. The style will adjust your
fonts and line spacing. Do not change the font sizes or line spacing to squeeze more text into a limited number of
pages. Use italics for emphasis; do not underline. 

To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or
copy the image to the Windows clipboard and then Edit | Paste Special | Picture (with “float over text” unchecked). 

DBIT will do the final formatting of your paper. If your paper is intended for a conference, please observe the
conference page limits. 

A. Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been

defined  in  the  abstract.  Abbreviations  such  as   SI,  ac,  and  dc  do  not  have  to  be  defined.  Abbreviations  that
incorporate periods should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title
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unless they are unavoidable.

B. Other Recommendations
Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” Avoid

dangling participles, such as, “Using (1), the potential was calculated.” [It is not clear who or what used (1).] Write
instead, “The potential was calculated by using (1),” or “Using (1), we calculated the potential.”

Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,” not “cc.” Indicate sample dimensions as “0.1 cm
 0.2 cm,” not “0.1   0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Use “Wb/m2” or “webers per
square meter,” not “webers/m2.” When expressing a range of values, write “7 to 9” or “7-9,” not “7~9.”

A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A
parenthetical sentence is punctuated within the parentheses.) In American English, periods and commas are within
quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not”
instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.”

If you wish, you may write in the first person singular or plural and use the active voice (“I observed that ...” or
“We observed that ...” instead of “It was observed that ...”). Remember to check spelling. If your native language is
not English, please get a native English-speaking colleague to carefully proofread your paper.

C. How to write a postscript file

First,  download  a  PostScript  printer  driver  from  http://www.adobe.com/support/downloads/pdrvwin.htm (for
Windows) or from http://www.adobe.com/support/downloads/ pdrvmac.htm (for Macintosh) and install the “Generic
PostScript Printer” definition. In Word, paste your figure into a new document. Print to a file using the PostScript
printer driver. File names should be of the form “fig5.ps.” Use Open Type fonts when creating your figures,  if
possible. A listing of the acceptable fonts are as follows: Open Type Fonts: Times Roman, Helvetica, Helvetica
Narrow,  Courier,  Symbol,  Palatino,  Avant  Garde,  Bookman,  Zapf  Chancery,  Zapf  Dingbats,  and  New Century
Schoolbook.

III . MATH

If  you  are  using  Word, use  either  the  Microsoft  Equation  Editor  or  the  MathType add-on
(http://www.mathtype.com)  for  equations  in  your  paper  (Insert  |  Object  |  Create  New  |  Microsoft  Equation
orMathType Equation). “Float over text” should not be selected. 

A. EQUATIONS

Number equations consecutively with equation numbers in parentheses flush with the right margin, as in (1). First
use the equation editor to create the equation. Then select the “Equation” markup style. Press the tab key and write
the equation number in parentheses. To make your equations more compact, you may use the solidus ( / ), the exp
function, or  appropriate  exponents.  Use parentheses  to avoid ambiguities  in denominators.  Punctuate equations
when they are part of a sentence, as in

(1)

Be  sure  that  the  symbols  in  your  equation  have  been  defined  before  the  equation  appears  or  immediately
following. Italicize symbols (T might refer to temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)” or
“equation (1),” except at the beginning of a sentence: “Equation (1) is ...”

IV. UNITS

Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as
secondary  units  (in  parentheses).  This  applies  to  papers  in  data  storage. For  example,  write  “15  Gb/cm2 (100
Gb/in2).” An exception is when English units are used as identifiers in trade, such as “3½-in disk drive.” Avoid
combining  SI  and  CGS units,  such  as  current  in  amperes  and  magnetic  field  in  oersteds.  This  often  leads  to
confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for
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each quantity in an equation.

The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic
flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g.,
“A·m2.”

V. SOME COMMON MISTAKES

The word “data” is plural, not singular. The subscript for the permeability of vacuum µ 0 is zero, not a lowercase
letter “o.” The term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance”
or “remnant.” Use the word “micrometer” instead of “micron.” A graph within a graph is an “inset,” not an “insert.”
The word “alternatively” is preferred to the word “alternately” (unless you really mean something that alternates).
Use the word “whereas” instead of “while” (unless you are referring to simultaneous events). Do not use the word
“essentially” to mean “approximately” or “effectively.” Do not use the word “issue” as a euphemism for “problem.”
When compositions are not specified, separate chemical symbols by en-dashes; for example, “NiMn” indicates the
inter-metallic compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x.

Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun),
“complement”  and  “compliment,”  “discreet”  and  “discrete,”  “principal”  (e.g.,  “principal  investigator”)  and
“principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer.” 

Prefixes such as “non,” “sub,” “micro,” “multi,” and “ultra” are not independent words; they should be joined to
the words they modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.”
(it is also italicized). The abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example”
(these abbreviations are not italicized).

Fig. 1.Magnetization as a function to an applied field. Note that “Fig.” is abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the caption. 

VI. GUIDELINES FOR GRAPHICS PREPARATION
AND SUBMISSION

A. Types of Graphics

The following list outlines the different types of graphics published in DBIT Tech journals. They are categorized
based on their construction, and use of color / shades of gray:

A. COLOR/GRAY SCALE FIGURE
Figures that are meant to appear in color, or shades of black/gray. Such figures may include photographs, 
illustrations, multicolor graphs, and flowcharts



B. LINEAR FIGURES
Figures that are composed of only black lines and shapes. These figures should have no shades or half­tones of gray.
Only black and white

C. AUTHOR PHOTOS
Head and shoulders shot of authors will disappear at the end of the paper.

D. TABLES
Data charts that are typically black and white, but may include color sometimes

B. Multipart Figures

Figures compiled of more than one sub-figure presented side-by-side, or stacked. If a multi part figure is made up of
multiple figure types (one part  is lineart,  and another is gray scale or color) the figure should meet the stricter
guidelines.

C. File Formats For Graphics

Format and save your graphics using a suitable graphics processing program that will allow you to create the
images as PostScript (PS), Encapsulated PostScript (.EPS), Tagged Image File Format (.TIFF), Portable Document
Format (.PDF), or Portable Network Graphics (.PNG) sizes them, and adjusts the resolution settings. If you created
your source files

TABLE I
UNITS FOR MAGNETIC PROPERTIES

Symb
ol

Quantity
Conversion from Gaussian

and
CGS EMU to SI a

 magnetic flux 1 Mx 108Wb = 108 V·s
B magnetic flux 

density, 
magnetic 
induction

1 G  104 T = 104Wb/m2

H magnetic field 
strength

1 Oe 103/(4) A/m

m magnetic moment 1 erg/G = 1 emu 
 103 A·m2 = 103 J/T

M magnetization 1 erg/(G·cm3) = 1 emu/cm3

 103 A/m
4M magnetization 1 G  103/(4) A/m
 specific 

magnetization
1 erg/(G·g) = 1 emu/g  1 
A·m2/kg

j magnetic dipole 
moment

1 erg/G = 1 emu 
 4 1010Wb·m

J magnetic 
polarization

1 erg/(G·cm3) = 1 emu/cm3

 4 104 T
, susceptibility 1  4
 mass 

susceptibility
1 cm3/g  4 103 m3/kg

 permeability 1  4 107 H/m 
  = 4 107Wb/(A·m)

r relative 
permeability

r

w, W energy density 1 erg/cm3 101 J/m3

N, D demagnetizing 
factor

1  1/(4)

Vertical lines are optional in tables. Statements that serve as captions for the entire table do not need footnote letters. 



aGaussian units are the same as cg emu for magnetostatics; Mx = maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T =
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.

in one of the following programs you will be able to submit the graphics without converting to a PS, EPS, TIFF,
PDF, or PNG file: Microsoft Word, Microsoft  Power Point, or Microsoft Excel. Though it is not required, it  is
recommended that these files be saved in PDF format rather than DOC, XLS, or PPT. Doing so will protect your
figures from common font and arrow stroke issues that occur when working on the files across multiple platforms.
When submitting your final paper, your graphics should all be submitted individually in one of these formats along
with the manuscript.

D. Sizing of Graphics
   Most charts, graphs, and tables are one column wide (3.5 inches / 88 millimeters / 21 picas) or page wide (7.16
inches / 181 millimeters / 43 picas). The maximum depth a graphic can be is 8.5 inches (216 millimeters / 54 picas).
When choosing the depth of a graphic, please allow space for a caption. Figures can be sized between column and
page widths if the author chooses, however it is recommended that figures are not sized less than column width
unless when necessary. 

There  is  currently  one  publication  with  column  measurements  that  don’t  coincide  with  those  listed  above.
PROCEEDINGS OF THE DBIT TECH has a column measurement of 3.25 inches (82.5 millimeters / 19.5 picas). 

The final printed size of author photographs is exactly 1 inch wide by 1.25 inches tall (25.4millimeters x 31.75
millimeters / 6 picas x 7.5 picas). Author photos printed in editorials measure 1.59 inches wide by 2 inches tall (40
millimeters x 50 millimeters  / 9.5 picas x 12 picas).

E. Resolution
The proper resolution of your figures will depend on the type of figure it is as defined in the “Types of Figures” 
section. Author photographs, color, and grayscale figures should be at least 300dpi. Lineart, including tables should 
be a minimum of 600dpi.

F. Vector Art
While DBIT Tech does accept, and even recommends that authors submit artwork in vector format, it is our policy

is to rasterize all figures for publication. This is done in order to preserve the figures’ integrity across multiple 
computer platforms. 

G. Color Space
The term  color space  refers to the entire sum of colors that can be represented within the said medium. For our
purposes,   the   three   main   color   spaces   are   Grayscale,   RGB   (red/green/blue)   and   CMYK
(cyan/magenta/yellow/black). RGB is generally used with on­screen graphics, whereas CMYK is used for printing
purposes.

All color figures should be generated in RGB or CMYK color space. Grayscale images should be submitted in
Grayscale color space. Line art may be provided in grayscale OR bitmap colorspace. Note that “bitmap colorspace”
and   “bitmap   file   format”   are   not   the   same   thing.   When   bitmap   color   space   is   selected,   .TIF/.TIFF   is   the
recommended file format.

H. Accepted Fonts within Figures
When preparing your graphics DBIT Tech suggests that you use of one of the following Open Type fonts: Times

New Roman, Helvetica, Arial, Cambria, and Symbol. If you are supplying EPS, PS, or PDF files all fonts must be
embedded. Some fonts may only be native to your operating system; without  the fonts embedded, parts of  the
graphic may be distorted or missing.

A safe option when finalizing your figures is to strip out the fonts before you save the files, creating “outline” 
type. This converts fonts to artwork what will appear uniformly on any screen.

I. Using Labels Within Figures

1) Figure Axis Labels



Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity
“Magnetization,” or “Magnetization M,” not just “M.” Put units in parentheses. Do not label axes only with units. As
in Fig. 1, for example, write “Magnetization (A/m)” or “Magnetization (Am1),” not just “A/m.” Do not label axes
with a ratio of quantities and units. For example, write “Temperature (K),” not “Temperature/K.” 

Multipliers can be especially confusing. Write “Magnetization (kA/m)” or “Magnetization (103 A/m).” Do not
write “Magnetization (A/m)  1000” because the reader would not know whether the top axis label in Fig. 1 meant
16000 A/m or 0.016 A/m. Figure labels should be legible, approximately 8 to 10 point type.

2) Subfigure Labels in Multipart Figures and Tables
Multipart figures should be combined and labeled before final submission. Labels should appear centered below
each subfigure in 8 point Times New Roman font in the format of (a) (b) (c). 

J. File Naming

Figures (line artwork or photographs) should be named starting with the first 5 letters of the author’s last
name. The next characters in the filename should be the number that represents the sequential location of this image
in your article.  For example,   in  author  “Anderson’s”  paper,   the first   three figures  would be  named ander1.tif,
ander2.tif, and ander3.ps.

Tables should contain only the body of the table (not the caption) and should be named similarly to figures,
except that ‘.t’ is inserted in­between the author’s name and the table number. For example, author Anderson’s first
three tables would be named ander.t1.tif, ander.t2.ps, ander.t3.eps.

Author photographs should be named using the first five characters of the pictured author’s last name. For
example, four author photographs for a paper may be named: oppen.ps, moshc.tif, chen.eps, and duran.pdf.  

If two authors or more have the same last name, their first initial(s) can be substituted for the fifth, fourth,
third... letters of their surname until the degree where there is differentiation. For example, two authors Michael and
Monica Oppenheimer’s photos would be namedoppmi.tif, and oppmo.eps.

K. Referencing a Figure or Table within your paper

When referencing your figures and tables within your paper, use the abbreviation “Fig.” even at the beginning of a
sentence. Do not abbreviate “Table.” Tables should be numbered with Roman Numerals.

L. Checking your figures

The DBIT Tech Graphics Checker Tool enables authors to pre-screen their graphics for compliance with DBIT
Tech Transactions and Journals standards before submission. The online tool, located at http://graphicsqc.ieee.org/,
allows authors to upload their graphics in order to check that each file is the correct file format, resolution, size and
color space; that no fonts are missing or corrupt; that figures are not compiled in layers or have transparency, and
that they are named according to the DBIT Tech Transactions and Journals naming convention. At the end of this
automated process, authors are provided with a detailed report on each graphic within the web applet, as well as by
email.

M. Submitting your Graphics

Because  DBIT  Tech  will  do  the  final  formatting  of  your  paper,  
you do not need to position figures and tables at the top and bottom of each column. In fact, all figures, figure
captions, and tables can be placed at the end of your paper. In addition to, or even in lieu of submitting figures
within your final manuscript, figures should be submitted individually, separate from the manuscript in one of the
file formats listed above in section VI-J. Place figure captions below the figures; place table titles above the tables.
Please do not include captions as part of the figures, or put them in “text boxes” linked to the figures. Also, do not
place borders around the outside of your figures.

http://graphicsqc.ieee.org/


N. Color Processing and Printing a DBIT Tech-Journal

All DBIT Tech-Journal allow an author to publish color figures and automatically convert them to grayscale for
print versions. In most journals, figures and tables may alternatively be printed in color if an author chooses to do so.
Please note that this service comes at an extra expense to the author. If you intend to have print color graphics,
include a note with your final paper indicating which figures or tables you would like to be handled that way, and
stating that you are willing to pay the additional fee.

VII. CONCLUSION

A conclusion section is not required. Although a conclusion may review the main points of the paper, do not 
replicate the abstract as the conclusion. A conclusion might elaborate on the importance of the work or suggest 
applications and extensions

APPENDIX

Appendixes, if needed, appear before the acknowledgment.

ACKNOWLEDGMENT

The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use
the singular heading even if you have many acknowledgments.  Avoid expressions such as “One of us (S.B.A.)
would like to thank ...  .” Instead, write “F. A. Author thanks ...  .”In most cases,  sponsor and financial  support
acknowledgments are placed in the unnumbered footnote on the first page, not here.

REFERENCES AND FOOTNOTES

A. References

References need not be cited in text. When they are, number citations on the line, in square brackets inside the
punctuation.  Multiple references are each numbered with separate brackets. When citing a section in a book, please
give the relevant page numbers. In text, refer simply to the reference number. Do not use “Ref.” or “reference”
except at the beginning of a sentence: “Reference [3] shows ....” Please do not use automatic endnotes in  Word,
rather, type the reference list at the end of the paper using the “References” style.

Reference  numbers  are set  flush left  and form a  column of their  own,  hanging out  beyond the body of  the
reference. The reference numbers are on the line, enclosed in square brackets. In all references, the given name of
the author or editor is abbreviated to the initial only and precedes the last name. Use them all; use  et al. only if
names are not given. Use commas around Jr., Sr., and III in names. Abbreviate conference titles.  When citing DBIT
Tech transactions, provide the issue number,  page range, volume number, year,and/or month if available. When
referencing  a  patent,  provide  the  day  and  the  month  of  issue,  or  application.  References  may  not  include  all
information; please obtain and include relevant information. Do not combine references. There must be only one
reference with each number. If there is a URL included with the print reference, it can be included at the end of the
reference.

Other than books, capitalize only the first word in a paper title, except for proper nouns and element symbols. For
papers published in translation journals,  please give the English citation first, followed by the original  foreign-
language citation See the end of this document for formats and examples of common references. For a complete
discussion of references and their formats, see “The DBIT Tech Style Manual,” available as a PDF link off the
Author Digital Toolbox main page.

B. Footnotes
Number footnotes  separately in superscripts (Insert  |  Footnote).1 Place the actual  footnote at  the bottom of the
column in which it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see

1



Table I). 

VIII. SUBMITTING YOUR PAPER FOR REVIEW

A. Review Stage Using Word 6.0 or Higher

If you want to submit your file with one column electronically, please do the following:
--First, click on the View menu and choose Print Layout.

--Second, place your cursor in the first paragraph. Go to the Format menu, choose Columns, choose one
column Layout, and choose “apply to whole document” from the dropdown menu.

--Third, click and drag the right margin bar to just over 4 inches in width.
The graphics will stay in the “second” column, but you can drag them to the first column. Make the graphic wider

to push out any text that may try to fill in next to the graphic.

B. Final Stage Using Word 6.0

When you submit  your final  version (after  your paper has  been accepted),  print  it  in a  two-column format,
including figures and tables. You must also send your final manuscript on a disk, via e-mail, or through a Web
manuscript submission system as directed by the society contact. You may use Zipfor large files, or compress files
using Compress, Pkzip, Stuffit, or Gzip.

Also,  send a sheet  of  paper or  PDF with complete contact  information for  all  authors.  Include full  mailing
addresses, telephone numbers, fax numbers, and e-mail addresses. This information will be used to send each author
a  complimentary  copy  of  the  journal  in  which  the  paper  appears.  In  addition,  designate  one  author  as  the
“corresponding  author.”  This  is  the  author  to  whom proofs  of  the  paper  will  be  sent.  Proofs  are  sent  to  the
corresponding author only

C. Copyright
An copyright form should accompany your final submission. You can get a .pdf, .html, or .doc version. Authors are
responsible for obtaining any security clearances.

IX. EDITORIAL POLICY

Submission of a manuscript is not required for participation in a conference. Do not submit a reworked version of
a paper you have submitted or published elsewhere. Do not publish “preliminary” data or results. The submitting
author  is  responsible for  obtaining  agreement  of  all  coauthors  and  any  consent  required  from sponsors  before
submitting  a  paper.  The  DBIT  Tech-Journal  Department  strongly  discourages  courtesy  authorship.  It  is  the
obligation of the authors to cite relevant prior work.

The DBIT Tech-Journal does not publish conference records or proceedings. The department does publish papers
related to conferences that have been recommended for publication on the basis of peer review. As a matter of
convenience and service to the technical community, these topical papers are typically collected and published in
one special issue of most transactions publications.

At least two reviews are required for every paper submitted. For conference-related papers, the decision to accept
or reject a paper is made by the conference editors and publications committee; the recommendations of the referees
are advisory only. Indecipherable English is a valid reason for rejection.  Authors of rejected papers may revise and
resubmit them as regular papers, whereupon they will be reviewed by two new referees.

X. PUBLICATION PRINCIPLES

The two types of contents of that are published are;  1) peer-reviewed and 2) archival. The Transactions and
Journals Department publishes scholarly articles of archival value as well as tutorial expositions and critical reviews

It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try
to integrate the footnote information into the text.



of classical subjects and topics of current interest. 
Authors should consider the following points:

1) Technical papers submitted for publication must advance the state of knowledge and must cite relevant prior
work. 

2) The length of a submitted paper should be commensurate with the importance, or appropriate to the complexity,
of the work. For example, an obvious extension of previously published work might not be appropriate for
publication or might be adequately treated in just a few pages.

3) Authors must convince both peer reviewers and the editors of the scientific and technical merit of a paper; the
standards of proof are higher when extraordinary or unexpected results are reported. 

4) Because replication is required for scientific progress, papers submitted for publication must provide sufficient
information  to  allow readers  to  perform  similar  experiments  or  calculations  and  use  the  reported  results.
Although not everything need be disclosed, a paper must contain new, useable, and fully described information.
For example, a specimen’s chemical composition need not be reported if the main purpose of a paper is to
introduce a new measurement technique. Authors should expect to be challenged by reviewers if the results are
not supported by adequate data and critical details.

5) Papers  that  describe  ongoing  work  or  announce  the  latest  technical  achievement,  which  are  suitable  for
presentation at a professional conference, may not be appropriate for publication.

REFERENCES

Basic format for books:
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Examples:

[6] J.  U.  Duncombe,  “Infrared  navigation—Part  I:  An  assessment  
of feasibility,” IEEE Trans. Electron Devices, vol. ED-11, no. 1, pp. 34–39, Jan. 1959.

[7] E.  P.  Wigner,  “Theory  of  traveling-wave  optical  laser,”Phys.  Rev.,  
vol. 134, pp. A635–A646, Dec. 1965.

[8] E. H. Miller, “A note on reflector arrays,” IEEE Trans.Antennas Propagat., to be published.

Basic format for reports:

[9] J. K. Author, “Title of report,” Abbrev. Name of Co., City of Co., Abbrev. State, Rep. xxx, year.
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